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popular for its balance of power efficiency and
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Javelin Stamp Integrated Development Environment (Javelin Stamp IDE) offers the features 
that you would commonly expect from a source-level debugger:  
 

• Multiple breakpoints 
• Stack backtrace 
• Inspection of all variables and objects, both static and dynamically allocated  
• Single-step, run, stop, reset  
• Built-in bi-directional serial message terminal for System.out.println() and 

Terminal.getChar() type debugging 
 
The Javelin Stamp IDE is introduced in Chapter 2, and then discussed in more detail in 
Chapter 5.  This IDE makes real-time debugging so easy that a PC emulator is completely 
unnecessary.  It is just as easy to develop and debug on the Javelin module itself.   

 

Virtual Peripherals 
The Javelin Stamp firmware supports a variety of Virtual Peripherals (VPs).  The VPs are 
separated into two separate categories, foreground and background.  The background 
processes allow you to create UARTs, pulse trains, and a timer.  Once created, background 
VP objects run independently from the program.  Since time-sensitive tasks are taken care of 
by the VPs in the background, designs that used to be difficult become easy.  For example, 
serial communication does not stop just because the Javelin is measuring the duration of an 
incoming pulse.  The programmer simply needs to periodically check the serial buffer in the 
foreground code.    Below is a list of background and foreground VPs. 

Background VPs 
• UART (Full duplex, HW flow control, buffered) 
• PWM 
• 32-bit Timer 
• 1-bit DAC  
• Delta/Sigma ADC 

Foreground VPs 
• Pulse count  
• Pulse width measurement 
• Pulse generation  
• RC Timer  
• SPI master 
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  static int dsTemp(int command){ 
    CPU.writePin(enablePin,true); 
    CPU.shiftOut(dataPin,clockPin,8,CPU.SHIFT_LSB,command); 
    data = ((CPU.shiftIn(dataPin,clockPin,9,CPU.POST_CLOCK_LSB)>>7)); 
    CPU.writePin(enablePin,false); 
 
    sign = data >> 8; 
    if ( sign == 1 ) { 
      return -data; 
    } 
    else 
      return data; 
  }                                                  // end dsTemp 
 
  // The main routine calls the dsInit method to initialize the 
DS1620,  
  // then it gets the temperature value from the dsTemp method and 
displays it.  
 
  public static void main(){ 
 
    dsInit(setup); 
    while (true){ 
      System.out.print(HOME); 
      System.out.println ("Celsius temperature: "); 
      System.out.println(dsTemp(READ_TEMP)/2);       // Divide by 2 
for deg-C 
      CPU.delay(5000); 
    }                                                // end while 
  }                                                  // end main 
}                                                    // end class 
declaration 

Communicating with Other Computers 
Using the built-in Uart virtual peripheral, it is easy to communicate with a PC or other 
microcontroller.  Since virtual peripherals always run in the background, you don’t have to 
constantly poll for serial input.  If input arrives while your program is doing something else, 
the virtual peripheral will buffer the data for you until you decide to process it.  Each Uart 
object handles communication in one direction, so for two-way communications, you’ll need 
two Uart objects. 
 

You can find more information about the Uart class in 
Chapter 9. 
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The Javelin Stamp IDE (Integrated Development Environment) provides a work environment 
where you can write, run, and debug your Javelin Stamp programs.  In addition, you can view 
the javadoc documentation from within the IDE. 

Starting the IDE 
You can run the IDE by selecting the icon from your Start menu.  From Windows, press on 
the Start button on your menu bar.  Mouse up to Programs, scroll over and mouse to the 
Javelin Stamp, scroll over once more and select the IDE and the program will begin.  You 
may wish to maximize the window (double click on the title bar, use the system menu on the 
left-hand side of the title bar, or use the maximize button to the right-hand side of the title 
bar). 
 
By default, you’ll see two command areas just below the title bar.  The first area holds the 
main menu (which has items for File, Edit, etc.).  The second area is a toolbar that has small 
icons to execute common methods.  Below the tool bar, you’ll see a tab that reads 
Untitled.java.  This is the name of the file you are editing.  If you open multiple files, each 
will have its own tab and you can switch between them by clicking on the tabs.  The area 
below the tab is where the text will appear.  The gray area to the left will contain indicators 
while debugging, as you’ll see shortly.  

Setting Global Options 
Before you get started, it is a good idea to review the option settings found within the Global 
Options… under the Project menu.  The dialog (see Figure 5.1) that appears has three tabs.  
The first tab, Compiler, should contain the Class Path and the path to the compiler.  Having 
the correct Class Path is vital so that the IDE can find the library files required for your 
programs.  Be careful not to change the settings unless you are certain you know what you are 
doing (you’ll learn more about changing the Class Path at the end of this chapter). 
 

Figure 5.1 Global Options for IDE 
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(a) Compiler (b) Debugger (c) Documentation 

 
The Debugger tab has a single option that allows you to set the COM port you’ve used when 
connected your Javelin Stamp.  The IDE uses this port to communicate with the Javelin 
Stamp.  You can press the Auto button and the IDE will attempt to detect the Javelin Stamp 
automatically. 
 
The final tab, Documentation, allows you to set the path to the javadoc files and the javadoc 
program.  You’ll read more about javadoc later in this chapter. 
 
If you change things inadvertently, you can push the Default button to restore everything to its 
original state.  For now, the only thing you should change is the COM port setting on the 
Debugger tab. 

Starting a Project 
To start a project, you can just begin defining a class in the Untitled.java window.  However, 
it is easier if you use the Insert Template under the File menu to insert a prototypical class 
into the editor workspace. 
 
Here is the code inserted by the Insert Template command: 
 
import stamp.core.*; 
 
/** 
 * Put a one line description of your class here. 
 * <p> 
 * This comment should contain a description of the class. 
What it 
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 * is for, what it does, how it use it. 
 * 
 * You should rename the class and then save it in a file with 
 * exactly the same name as the class. 
 * 
 * @version 1.0 Date 
 * @author Your Name Here 
 */ 
public class MyClass { 
 
  // Put variables here. 
  static int myVar; 
 
  public static void main() { 
    // Your code goes here. 
  } 
 
} 
 
You’ll need to change MyClass to an appropriate name.  You’ll also want to alter the 
comments and myVar variable to suit your program.  Java requires that each file have only 
one public class and that the class have exactly the same name as the Java file (including the 
case of the name).  So if your class is MyFirstClass, you should save the file as 
MyFirstClass.java Save or Save As under the File menu. 
 
You can also ask the IDE to help you write your code by invoking specific templates.  If you 
press CONTROL+J while editing a file, you’ll see a list of templates you can insert.  For 
example, if you select the for (count) template, this will appear in your file: 
 
for ( int i = 0; i <; i++ ) { 
 
} 
 
If you’ve already typed a partial statement, pressing CONTROL+J will automatically insert 
the correct template without displaying a list.  For example, if you enter if and then press 
CONTROL+J, the IDE will automatically insert the code template for if.  
 
Table 5.1 shows the available templates and the keywords that will automatically invoke 
them. 
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Cut Remove the selection to the clipboard CONTROL+X 
Copy Copy the selection to the clipboard CONTROL+C 
Paste Paste the clipboard contents to the 

document 
CONTROL+V 

Select All Select all text CONTROL+A 
Find and ReplaceÉ  Find or find and replace text CONTROL+F 
Find Again Repeat last find operation F3 

Toolbars and Menubars 
You can move the main menu to different locations by grabbing the double vertical bar to the 
left-hand side of the menu and dragging.  You can move the menu anywhere horizontally, and 
you can move the menu to two different vertical locations. 
 
You can also drag the toolbars around in this fashion.  In addition, you can drag the toolbars 
into the main window area to convert them into floating windows.  If you want to restore 
them to their bar state, you can drag them to the top window border and they will stick.  By 
grabbing the double bar to the left-hand side of the toolbar, you can move the toolbar to 
different locations. 
 
Another way to issue commands is to right click on the file’s tab at the top of the editor 
screen.  Right clicking will display a menu that will allow you to compile, debug, program, 
manipulate projects (covered shortly), or close the current file.  Note that the menu commands 
always apply to the current document, even if you right click another document’s tab. 

Class Path Considerations 
One of the most critical aspects of working with any Java or Java-like development tools is 
the CLASSPATH.  Each time you name a class in your program, the compiler searches for 
the appropriate class file by searching the directories named in the CLASSPATH (you’ll find 
more about this topic in Chapter 3). 
 
It is crucial that the directories in the CLASSPATH refer to the correct class files, and not 
class files aimed at another target system (like the PC, for example).  In addition, if you create 
your own libraries of code, you’ll want to place the correct directories for that code in the 
CLASSPATH. 
 
Selecting Global Options under the Project menu will give you a Global Options window.  
You can select the Compiler tab to view the CLASSPATH variable.  You can directly change 
the string you find there if you like.  It is simply a list of paths separated by semicolons.  The 
paths should be absolute (e.g., c:\myclasses\lib1 instead of ..\lib1). 
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computation might divide by zero, depending on the input parameters.  Of course, you could 
test for a zero denominator before dividing, but what do you do if you detect this condition?  
You could print an error message, but that presupposes your program can display a message 
(remember, I said this routine was general-purpose). 
 
A common solution is to return an error code to the calling method.  This is not always good, 
though.  What if the calling program is another general routine?  It will have to propagate the 
error condition somehow.  What if the calling program doesn’t check for an error condition?  
You can solve these problems with exceptions. 
 
When an event occurs, like a division by zero, Java throws an exception.  Your code can 
handle the exception by wrapping the code in a try block see Program Listing 6.8.  In this 
case there isn’t much advantage to using exceptions.  However, suppose the equation inside 
the try block called other methods to do its work. 

Program Listing 6.8 - Exceptions Ex1 

public class Ex1 { 
  public static void main() { 
    int x=0; 
    int y=20; 
    int z; 
    try { 
      z=y/x; 
    }                                                // end try 
    catch (Exception e) { 
      System.out.println("Divide by zero"); 
    }                                                // end catch 
  }                                                  // end main 
}                                                    // end class 
declaration 
 
Even if code in these other methods divided by zero, the catch block beneath the try 
would be activated (unless, of course, the called methods provided their own try block.  
Consider this example. 

Program Listing 6.9 - Exceptions Ex2 

public class Ex2 { 
  static int docomp(int a, int b) { 
    return a/b; 
  }                                                  // end docomp 
  public static void main() { 

sdill
Comment [22]: This code might have some 
issues, I tried adding println’s  in the try and in the 
catch and got some errors from it.  See Twiki 

sdill
Comment [23]: This may need re-work as well 
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    if (b==0) throw new ScaleError(); 
      return a/b; 
  } 
   
  public static void main() { 
    int x=0; 
    int y=20; 
    int z; 
    try { 
      z=docalc(y,x); 
    } 
    catch (ScaleError e) { 
      System.out.println("Scale Error"); 
    } 
    catch (Exception e) { 
      System.out.println("Unknown exception"); 
    } 
  } 
} 
 
Notice that there are multiple catch clauses.  The first one is the most specific type of 
exception.  The last one catches any Exception object including objects that derive from 
Exception.  That’s why that clause must come last.  If it were first, it would match the 
ScaleError exception and the second catch clause would never execute.  Try removing 
the try and catch block and rebuilding the program.  You’ll find that the compiler rejects 
the program because it sees that there is an unchecked exception.  Of course, you could mark 
main so that it throws a ScaleError exception.  Then the exception would terminate the 
program like an unchecked exception. 

Packages and CLASSPATH 
When Java must locate a class file, it searches the directories listed in the CLASSPATH 
environment variable.  This is a list of directories separated by semicolons. 
  
Even with multiple directories, you’d quickly clutter each directory with class files.  For that 
reason, Java supports packages.  Packages are somewhat like subdirectories that contain class 
files.  For example, suppose your CLASSPATH variable contains a single directory named 
C:\Classes.  When you attempt to load an ordinary class, the IDE will search in the 
C:\Classes directory.  
  
However, some classes belong to a package, a group of related classes.  For example, you 
might want to refer to a Cache object.  That object is in the stamp.util package, so to 
declare it, you could write: 

sdill
Comment [25]: ANDY: Should the title 
Classpath be CLASSPATH instead? 
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stamp.util.Cache  = new stamp.util.Cache(); 
  
The JVM would look for the Cache.class file in a subdirectory of one of the 
CLASSPATH directories.  In this case, there is only one directory (C:\Classes) so the 
class file should be in C:\Classes\javelin stamp\util\Cache.class.  Of 
course, if there were more directories listed in the CLASSPATH variable, the IDE would also 
search those directories, always looking in the javelin stamp\util subdirectory. 
  
It wouldn’t be very convenient to have to write stamp.util.Cache every time you 
wanted to use it.  By default, if you use a class name, it can only reside in one of the top-level 
CLASSPATH directories or in the special package java.lang.  However, you can use the 
import statement to mark certain packages that you want to behave as though they were 
local. 
  
If you wanted to use the name Cache instead of stamp.util.Cache, you can add the 
following line at the start of your java source file: 
 
import stamp.util.Cache; 
 
You can also get all the classes in stamp.util by writing: 
 
import stamp.util.*; 
 
Keep in mind that you never have to use import.  If you prefer, you can simply use fully 
qualified class names everywhere.  Still, using import makes your programs much more 
readable so you’ll want to use it where appropriate.  A common mistake beginning Java 
programmers make is to try something like this: 
 
import System.out.println; 
println(“Hello World”); 
 
This won’t work!  That’s because System is an object (part of the java.lang package), 
but out is a static field of this object.  This field is an object reference that has a method 
called println.  The import statement only works with classes.  You can’t import a field 
or method. 

Summary 
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You could read an entire book on Java – there are plenty around.  However, this chapter, 
along with the examples in the next few chapters, will give you a lot of practice with Java.  
You can also find many online tutorials, books, and documentation on Java.  Be sure to check 
out the online resources section for more information.  Be aware, though, that many books 
and other materials will focus on writing graphical programs, not embedded systems. 
 
This chapter may leave you wondering why use Java.  In the next chapter, however, you’ll see 
that Java’s networking capability is a real winner.  And Java’s cross platform ability will 
serve you well in a networked environment. 

Online Resources 
http://java.sun.com 

  Java’s home on the Web.  Free downloads of the JDK, tutorials, news, and 
more. 

http://www.norvig.com/java-iaq.html 
Java Infrequently Asked Question (IAQ) list. 

http://mindprod.com/gotchas.html 
Java gotchas 

http://www.afu.com/javafaq.htm 
Java programmer’s FAQ 

http://www.mindspring.com/~chroma/docwiz/ 
Adds  java doc comments to your code  

http://uranus.it.swin.edu.au/~jn/java/style.htm 
Automatically format your Java code 

Javelin Stamp Keyword Reference 

abstract  
The abstract keyword has two possible methods.  You can mark a method as abstract 
to indicate that the class contains no code for the method.  That implies that you can’t 
instantiate the class, only extend it.  Classes that extend the class must either implement the 
abstract method, or also be an abstract class. 
 
You can also mark an entire class as abstract – any class that contains at least one abstract 
method is an abstract class.  
 
Examples: 
 
abstract class AbaseClass { 
  abstract void someMethod(); 
} 
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y = 5/256*x; 
 
Instead, you want to write: 
 
y = (5*x)/256;  // parenthesis not necessary, but added for 
clarity 
 
Even writing it this way, any value below 52 will result in a 0 result.  You might prefer to 
compute decivolts (1/10 of a volt units) instead by scaling everything up by 10.  For example: 
 
y = (50*x)/256; 
 
If you need to find the volts, you can use the / operator.  The % operator could determine the 
fractional (1/10) volt units.  For example: 
 
System.out.println("Volts = " + y/10 + "." + y%10); 
 
Examples: 
 
y = 10 + 33 / 17 % 3 * 100;  // answer is 110 

<<, >>, >>> 
These operators all shift their left argument to the left (<<) or right (>> and >>>) the number 
of times specified by their right argument.  Shifting to the left is equivalent to multiplying by 
powers of two, and shifting right is the same as dividing by a power of 2.  So writing 100>>4 
is the same as writing 100/16 (because 2 to the 4th power is 16).  In addition, shifting is 
typically faster than multiplication and division. 
 
It is possible to rewrite certain common multiplication statements as sums of shifts to realize 
faster execution.  For example, when working with decimal numbers, you’ll often need to 
multiply by 10.  Observing that 10 is actually 8+2, you can rewrite 10*x as 
(x<<3)+(x<<1).  
 
The << operator always sets the least-significant bit of the result to zero.  The >> operator 
preserves the most significant bit (which represents the sign).  This makes positive numbers 
stay positive and negative numbers stay negative.  If you really want to zero fill the most 
significant bit, use >>> which is a true unsigned shift. 
 
Examples: 
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Your program will throw a NullPointerException if you attempt to access an object 
reference that is equal to null. 
 
Base Class: RuntimeException 
 
Methods: 
static RuntimeException throwIt() – Throw a run-time exception. 

Object 
Object is the top-level base class for all objects, even those that don’t explicitly extend 
anything.  Public methods of Object are available in all objects, since all objects extend 
Object. 
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Example: 
 
StringBuffer sb = new StringBuffer("ATDT"); 
sb.append(getTelephoneNumber());       //getTelephoneNumber 
returns String 
dial(sb.toString());                   //dial expects a String 
argument 

System 
The System object holds static items that apply to the system as a whole.  It is essentially 
a holder for global methods and variables.  
 
Base Class: Object 
 
Fields: 
static PrintStream out – A PrintStream used to send data back to the system 
console on the host PC. 
 
Example: 
 
System.out.println("Parallax"); 

Throwable 
Throwable is a base class for all exceptions. 
 
Base Class: Object 
 
Common derived classes: Error, Exception 
 
Methods: 
String getMessage () – Returns a message appropriate for the exception. 

The java.io Package 
The java.io package contains the PrintStream class.  This is the way that the Javelin 
Stamp can write data out to a stream.  A stream might be a serial I/O port, or any other input 
and output device that works with characters. 
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DAC object named dac.  This example also assumes that the dac object has already been 
declared and removed once.  Reinstalling the dac object involves installVP plus 
reassigning it a value: 
 
DAC dac = new DAC(CPU.pin2); 
dac.update(125); 
CPU.removeVP(dac); 
 
// Later in the program after pwm was installed and removed... 
CPU.installVP(dac); 
dac.update(125); 

message 
static void message(char [] data, int length) – Sends a message to the 
Messages from Javelin window.  Note that the text is a char array, not a string.  You can use 
String.toCharArray if you want to provide text in a String object.  You can also use 
System.out.println to send strings to the Messages from Javelin window. 

Example: 
 
char [] characters = {'a', 'b'}; 
CPU.message(characters,2); 
String s = "CDE"; 
CPU.message(s.toCharArray(),3); 

nap 
static void nap(int period) – Places the processor in a low power sleep state.  
All operations cease while the Javelin is napping.   
 

The Javelin Stamp can only call nap as a foreground 
process with no background processes running.  Before 
calling this method, you must use 
VirtualPeripheral.removeItem to uninstall any 
VPs that are installed.  See example below. 

 
The period argument can range from 0 to 7, depending on how long you want to the Javelin 
Stamp to nap (see below).  However, the nap time is only approximate and should not be 
used for timing where accuracy is required.  The primary reason you’ll use nap is to conserve 
power when operating the Javelin from batteries.  Here are the values for the period 
argument: 
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setInput, 174 
shiftln, 174 
short, 89, 125 
static, 33, 125 
StringBuffer, 42, 100, 104, 154, 192 
Strings, 104–5, 152, 192 

StringBuffer. See StringBuffer 

Calculations, 34 
char, 89 
Declaration, 89-91 
final, 32, 90-91 
int, 89 
short, 89 
static, 80 

 
Variables (continued) 

static final, 91 
Virtual Peripherals, xiv, 3, 145, 163, 

164, 173, 184 
ADC, 159 
Background, 3 
DAC, 59 
Foreground, 3 

    PWM, 58, 146, 184-185 

Virtual Peripherals 
Timer, 187 

    UART(s), 64, 188void, 99, 130 
volatile, 136 
  
         - W - 
while, 37–40, 88, 97, 115, 130 
wrapper, 109 

 


